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이 기기의 정보

특징

이 기기는 레이저 광을 사용하는 핫 스탬핑 프린터입니다.  호일을 사용하여 그림과 텍스트를 마킹하면
플라스틱 제품에 고급스러운 마킹이 됩니다.
전용 소프트웨어를 사용하여 마킹 데이터를 간편하게 생성 할 수 있습니다.

각 부의 명칭

본체

전원코드 연결부

USB 연결부

커버

헤드

베이스 테이블 

헤드 유닛

전원/이동 버튼

레이저 포인터 

잠금 레버
레이저 유닛
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헤드

호일은 렌즈에서 조사되는 레이저 광을 통해 소재에 전달됩니다.  렌즈는 소모품이므로 적절한시기에 
교체하십시오.

 P.51  "렌즈 수명 확인"

렌즈

소재 리테이너 

소재 리테이닝 프레임

이 프레임은 두꺼운 소재를 클램핑하여 고정합니다.  프레임이 고정되는 방향은 소재의 너비에 맞게
변경할 수 있습니다.

노브(대형)

라이징 테이블

이 테이블은 베이스 테이블 위에 설치하여 얇은 소재에도 마킹 작업을 할 수 있게 합니다.

헤드 감지 홀

이 기기의 정보
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Light-absorbing 필름

레이저 광으로 Light-absorbing 필름에 조사되면 빛이 열로 변환됩니다.  Light-absorbing 필름의 
앞면과 뒷면을 뒤집어 설치하면 빛을 열로 변환 할 수 없으므로 마킹이 수행되지 않습니다.  자세한   
내용은 P.52 "Light-absorbing 필름 교체"를 참조하십시오.

이 열은 호일을 소재에 전사합니다.

A
A 소재

레이저 광선

호일

Light-absorbing 필름

필름 프레임 

필름 리테이너의 바닥에 부착 된 접착 시트는 light-absorbing 필름을 고정하는 데 사용됩니다.

필름 프레임

이 기기의 정보
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헤드 감지 지그 

이 지그는 헤드를 감지할 때 사용됩니다.  지그는 높은 것과 낮은 것의 두 가지 유형이 있습니다.
소재의 두께에 따라 지그를 선택하여 사용하십시오.

이 기기의 정보
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기본 작동법

전원켜기

절차

[전원/이동] 버튼을 누릅니다.
헤드가 왼쪽 뒤쪽으로 이동하고 전원/이동 버튼의 램프가 켜집니다. 이 동작을 초기 동작이라고 
합니다.

Important : 전원 램프가 계속 깜박이는 경우

초기화 오류가 발생했습니다.  다음 섹션을 참조하여 오류의 원인을 제거하고 [전원/이동] 버튼을 다시 
누르십시오.

 P.89  "[전원/이동] 버튼이 깜박이는 경우"

전원 끄기 

절차

[전원/이동] 버튼을 1 초 이상 누릅니다.

표시등이 꺼지고 전원이 꺼집니다.
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소프트웨어 시작하기

Windows 10
① [시작] 버튼을 클릭합니다.
② [(사용하려는 소프트웨어)] 폴더에서 [(사용하려는 소프트웨어)] 아이콘을 클릭합니다.

Windows 8.1
① [시작] 화면에서        을 클릭합니다.
② [앱] 화면에서 [(사용하려는 소프트웨어)] 아이콘을 클릭합니다.

Windows 7
① [시작] 버튼을 클릭합니다.
② [모든 프로그램] (또는 [프로그램])을 클릭합니다.
③ [(사용하려는 소프트웨어)] 폴더에서 [(사용하려는 소프트웨어)] 아이콘을 클릭합니다.

소프트웨어 도움말 표시

소프트웨어를 시작하고 상단의 메뉴에서 [Help]-[Contents]를 클릭합니다. *현재는 영문만 지원합니다.

 P.10 "소프트웨어 시작하기"

기본 작동법
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마킹 흐름도 확인

P.16 "METAZAStudio의 출력 기기 지정"

기기의 전원을 켜고 컴퓨터에서 출력 할 기기로 선택합니다.

P.17  "소재 준비"

마킹이 될 소재에 대해 충족되어하는 여러 조건(소재의 재질 및 두께 등..)을 확인하십시오.

P.20  "소재 장착(소재 두께 : 0 ~ 26mm)"

P.22  "소재 장착(소재 두께 : 24 ~ 50 mm)"

P.26  "소재 장착(소재 두께 : 50 ~ 216 mm)"

기기에 소재를 장착 합니다.

P.32  "마킹 데이터 생성"

METAZAStudio를 사용하여 마킹 데이터를 만듭니다.

P.39  "마킹"

METAZAStudio에서 마킹 데이터를 출력합니다.

마킹 준비
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METAZAStudio 시작하기

Windows 10
① [시작] 버튼을 클릭합니다.
② [(Roland METAZAStudio)] 폴더에서 [(METAZAStudio)] 아이콘을 클릭합니다.

Windows 8.1
① [시작] 화면에서       을 클릭합니다.
② [앱] 화면에서 [(METAZAStudio)] 아이콘을 클릭합니다.

Windows 7
① [시작] 버튼을 클릭합니다.
② [모든 프로그램] (또는 [프로그램])을 클릭합니다.
③ [(Roland METAZAStudio)] 폴더에서 [(METAZAStudio)] 아이콘을 클릭합니다.

METAZAStudio가 시작 됩니다.

마킹 준비
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METAZAStudio 화면

No. 이름 기능의 개요

① 메뉴바
METAZAStudio에 대한 다양한 명령을 실행합니다.

 METAZAStudio 온라인 도움말("Commands(명령어)")

② 툴바

툴바에는 [Material] 및 [Open]과 같은 METAZAStudio 명령을 실행하기 위한 
버튼이 있습니다.

 METAZAStudio 온라인 도움말 ("Commands(명령어)"-"Toolbar Buttons(툴바 버튼)")

③ 페이지 피드 바

변수 필드에 데이터를 입력 한 경우 페이지 피드 바를 사용하여 화면에 표시되는 
페이지(레코드)를 지정합니다.  변수 데이터 마킹에 사용합니다.

 P.78  "변수 데이터 생성"

 METAZAStudio 온라인 도움말 ("Hints and Tips" > "Performing Variable Printing")

④ 상태 바

커서의 현재 위치, 모양에 대한 정보, 그리드 및 뷰 배율을 표시합니다.  포인터를 
도구 모음 단추로 이동하거나 메뉴 명령을 가리키면 단추 또는 명령에 대한 간략
한 설명이 왼쪽 가장자리에 나타납니다.

현재 커서 위치
커서의 현재 위치를 나타냅니다.  창 중앙 (두 중심선이 
교차하는 위치)의 위치는 (0, 0)입니다.

모양 정보

화면상의 개체(이미지, 텍스트 또는 모양)를 클릭하면 
나타납니다.  아래 그림과 같이 현재 도형의 중심 위치
와 크기가 표시됩니다.

그리드 피치
그리드 선의 피치(간격)를 표시합니다.  이를 클릭하면 
격자 모양과 관련된 메뉴 항목이 표시됩니다.

미리보기 보기 배율
미리보기의 현재 배율을 표시합니다.  이를 클릭하면 
보기의 배율을 변경할 수있는 메뉴가 표시됩니다.

마킹 준비
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11

No. 이름 기능의 개요

5 작업 영역

이것은 레이저가 움직일 수있는 영역입니다.  LD 드라이버로 설정된 소재의 
크기가 여기에 표시됩니다.

 P.85  "드라이버 기본설정 변경"

6
LP(레이저 포인터) 
이동 가능 영역 이 범위 내에서 LP를 이동할 수 있습니다.

7 LP 이동 불가 영역 이 영역 내에서 LP를 움직이면 예상치 못한 위치에서 LP가 조사 될 수 있습니
다.

8 중심선 창의 수직 및 수평 중심을 나타냅니다.

9 그리드
작업 영역에 표시되는 그리드 선 입니다.  이미지와 텍스트를 배치하기 위한 
가이드 역할을 합니다.

0 여백

이 여백은 작업 영역의 가장자리 내부에 있으며 마킹이 수행되지 않습니다.
METAZAStudio 설치시 기본 설정은 2mm입니다.  [File] 메뉴에서
[Preferences]을 선택하여 여백의 크기를 변경할 수 있습니다.

 P.32  "Step 1: 마킹 데이터 생성 준비"

A 헤드 감지 위치

창 내에서 작업을 수행하여 기기에 부착 된 위치와 동일한 위치 (뒤 왼쪽 모서
리 / 앞 오른쪽 모서리)에 헤드 감지 위치(지그장착위치)를 표시합니다.

 P.40  "마킹"

마킹 준비
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METAZAStudio에서 출력 기기 지정

절차

A 기기의 전원을 켭니다.

 P.9  "전원켜기"

B METAZAStudio를 시작 합니다.

 P.13  "METAZAStudio 시작하기"

C [File] → [Set up the printer]를 클릭합니다.

[인쇄 설정] 화면이 나타납니다.

D 데이터를 출력 할 프린터를 선택합니다.
① [DGSHAPE LD-300]를 클릭합니다.
② [OK]를 클릭합니다.

마킹 준비
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소재 준비

이 기기로 마킹하는 소재는 다음의 조건을 모두 충족해야합니다.

재질 

• Acrylic

• Polypropylene

• ABS

• Leather

• Polyurethane

• Vinyl chloride

두께

최대 : 216 mm

크기

폭 : 최대 323 mm

안정적으로 고정 할 수 있는 크기

이 기기에서 접착 시트와 리테이너를 사용하여 소재를 고정하십시오.  소재가 접착 시트 및 리테이너로 밖
으로 벗어나는 크기의 소재도 가능하지만 필수 요구 사항은 소재가 본체 내부에 단단히 고정 될 수 있는 크
기의 소재를 권장합니다.

라이징 테이블 사용시 : 두개의 헤드 감지 홀  중 하나는  덮이지 않는 소재의 크기

헤드 감지 홀 

라이징 테이블을 사용하지 않는 경우 : 헤드 감지 지그를 올바르게 장착 할 수있는 소재 크기

마킹 준비
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모양

마킹될 자리의 표면에 요철이 없어야합니다.

로드 중이거나 마킹 중에 기기의 움직이는 부분과 접촉하는 소재는 마킹이 불가능합니다.

소재의 가장자리가 
소재의 내부보다 높은 형태

Not OK

"L" 자 형태

평면도

단면도 

0.5mm 미만의 완만한 편차

헤드가 높이 편차를 따라가지 못하는 편차의 경우 올바른 마킹이 불가능합니다.

마킹 준비
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소재 장착

소재 고정 방법 선택

고정 방법은 소재의 두께에 따라 다릅니다.  일반적으로 아래와 같이 고정 합니다.

소재

D

소재
D

C

B
소재

B

소재
A

소재 두께 고정 방법

베이스 테이블에 포함 된 라이징 테이블을 놓고 
소재를 고정합니다.
 P. 20 "소재 장착(소재 두께 : 0 ~ 26mm)"

사용 항목

• 라이징 테이블 A
• 베이스 테이블 B

베이스 테이블에 소재를 고정합니다.
 P. 22 "소재 장착(소재 두께 : 24 ~ 50 mm)"

사용 항목

• 베이스 테이블 B

베이스 테이블을 제거하고 소재 리테이닝 프레임
으로 소재를 고정합니다.
 P. 26 "소재 장착(소재 두께 : 50 ~ 216 mm)"

사용 항목

• 높이 조절 블록 C
* 포함되지 않은 품목으로 별도로 준비하여 사용합니다.

• 소재 리테이닝 프레임 D

베이스 테이블을 제거하고 소재 리테이닝 프레임
으로 소재를 고정합니다.
 P. 26 "소재 장착(소재 두께 : 50 ~ 216 mm)"

사용 항목

• 소재 리테이닝 프레임 D

0 mm

24 mm 

26 mm 

50 mm 

190 mm 

216 mm 

Memo : 소재의 두께가 24 ~ 26mm인 경우

표면이 부드럽거나 두께가 26mm 미만인 소재에 마킹을 자주 수행하는 경우에는 라이징 테이블을 사용
하십시오.

 P. 20 "소재 장착(소재 두께 : 0 ~ 26mm)"
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소재 장착(소재 두께 : 0 ~ 26mm)

절차 

A 커버를 엽니다.

B 베이스 테이블에 라이징 테이블을 장착합니다.
라이징 테이블 하단에 있는 포지셔닝 핀을 베이스 테이블의 윗면에있는 구멍에 삽입합니다.

라이징 테이블

구멍

포지셔닝 핀

C 접착 시트를 부착합니다.
소재가 크면 두 장의 접착 시트를 사용하십시오.

소재 장착
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D 소재를 장착 합니다.

   소재를 배치하는 방법

헤드 감지 홀이 보일 정도로 두께가 14mm(0.55인치) 미만인 소재를 장착 합니다.

사용할 헤드 감지 홀에 따라 소재의 장착 위치를 올바르게 선택하십시오.

헤드 감지 홀 
(back left corner)

헤드 감지 홀
(front right corner)

METAZAStudio 창에서 선택한 헤드 감지 홀 위치를 설정합니다.

METAZAStudio 창에서 마우스 오른쪽 버튼을 클릭하고 [Head position detection]-[Back left 
corner] 또는 [Front right corner]를 클릭하여 헤드 감지 홀 위치를 설정합니다.

Load material having a thickness of 14 mm (0.55 in.) or more such that the head detection 
hole in the back left corner can be seen. 

앞 우측 모서리에 있는 헤드 감지 홀을에서 감지하면 헤드의 간섭이 발생하므로 왼쪽 뒤 모서리에 
있는 헤드 감지 홀을 사용하여 헤드를 감지합니다.

헤드 감지 홀(back left corner)

METAZAStudio 창에서 선택한 헤드 감지 홀 위치를 설정합니다.
METAZAStudio 창에서 마우스 오른쪽 버튼을 클릭하고 [Head position detection]-[Back left 
corner]를 클릭하여 헤드 감지 홀 위치를 설정합니다.

소재 장착
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• 소재가 너무 커서 테이블에 맞지 않는 경우 지지대를 사용하여 소재를 수평으로 고정하십시오.

• 접착 시트에 부착하는 것처럼 소재를 부드럽게 누릅니다.



Important!

마킹 할 표면의 이물질을 제거하십시오.

마킹 할  표면에 부착된 이물질을 제거하지 않고 마킹을 수행하면 마킹 품질이 저하 될 수 있습니다.

이것으로 소재를 장착하는 절차가 완료되었습니다.

 P.32  "마킹 데이터 생성"

소재 장착(소재 두께 : 24 ~ 50 mm)

절차

A 커버를 엽니다.

B METAZAStudio 창의 오른쪽 상단 모서리를 마우스 오른쪽 버튼으로 클릭하고 [Move LP here]을 클릭  
 합니다.

헤드가 오른쪽 뒤 모서리로 이동합니다.

창의 오른쪽 상단 모서리를 마우
스 오른쪽 버튼으로 클릭합니다.

소재 장착
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C 왼쪽 뒤 모서리에 있는 노브를 풉니다.

노브

D 헤드 감지 지그를 선택합니다.
소재의 두께에 따라 사용할 헤드 감지 지그를 선택합니다.
소재 두께 사용할 헤드 감지 지그
24 ~ 36 mm Low

36 mm ~ High

Important : 정확한 높이의 헤드 감지 지그를 사용하십시오.

잘못된 지그를 사용하면 헤드가 소재에 부딪혀 마킹 결함과 부품 손상이 일어날 수 있습니다.

E 헤드 감지 지그의 기다란 홈이 모서리에 있는 노브에 위치하도록 합니다.

기다란 홈 

소재 장착
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F 노브를 조입니다.
지그를 베이스 테이블과 수직이 될 수 있도록 바로 누르면서 고정합니다.

노브

METAZAStudio 창에서 선택한 헤드 감지 홀 위치를 설정합니다.
METAZAStudio 창에서 마우스 오른쪽 버튼을 클릭하고 [Head position detection]-[Back left 
corner]를 클릭하여 헤드 감지 홀 위치를 설정합니다.

G 베이스 테이블 위에 접착 시트를 놓습니다.
소재가 크면 두 장의 접착 시트를 사용하십시오.

H 마킹 할 소재를 장착 합니다. 

  소재를 배치하는 방법

Important!

마킹 할 표면의 이물질을 제거하십시오.

마킹 할  표면에 부착된 이물질을 제거하지 않고 마킹을 수행하면 마킹 품질이 저하 될 수 있습니다.

이것으로 소재를 장착하는 절차가 완료되었습니다.

 P.32  "마킹 데이터 생성"

소재 장착
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• 소재가 너무 커서 테이블에 맞지 않는 경우 지지대를 사용하여 소재를 수평으로 고정하십시오.

• 접착 시트에 부착하는 것처럼 소재를 부드럽게 누릅니다.



헤드 감지 지그를 전면 우측 코너에 고정하는 경우

헤드 감지 지그를 왼쪽 뒤 모서리에 고정 할 수없는 경우(예 : 테이블의 왼쪽 뒤 모서리에 소재를 배치 
할 때) 이 지그를 앞 오른쪽 모서리에 고정하십시오.

① 전면 오른쪽 모서리에있는 노브를 풉니다.

노브

② 헤드 감지 지그의 기다란 홈이 모서리에 있는 노브에 위치하도록 합니다.

기다란 홈 

③ 노브를 조입니다.

지그를 베이스 테이블과 수직이 될 수 있도록 바로 누르면서 고정합니다.

노브

소재 장착
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METAZAStudio 창에서 선택한 헤드 감지 홀 위치를 설정합니다.
METAZAStudio 창에서 마우스 오른쪽 버튼을 클릭하고 [Head position detection]-[Front 
right corner]를 클릭하여 헤드 감지 홀 위치를 설정합니다.

소재 장착(소재 두께 : 50 ~ 216 mm)

소재 두께가 50 ~ 190mm 인 경우 별도의 높이 조정 블록을 준비합니다.

기기 바닥에서 마킹 할 면의 높이 ( "소재 두께 + 높이 조정 블록")가 190mm 이상인지 확인합니다.

소재 두께

높이 조정 블록 

마킹 할 면 

절차

A 커버를 엽니다.

소재 장착
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B 베이스 테이블을 제거합니다.

C 작업 영역 바닥에 접착 시트를 놓습니다.
소재가 크면 두 장의 접착 시트를 사용하십시오.

접착 시트

D METAZAStudio 창의 오른쪽 상단 모서리를 마우스 오른쪽 버튼으로 클릭하고 [Move LP here]를 
      클릭합니다. 

헤드가 오른쪽 뒤의 모서리로 이동합니다.

창의 오른쪽 상단 모서리를 마우
스 오른쪽 버튼으로 클릭합니다.

소재 장착
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E 왼쪽 뒤 모서리에 있는 노브를 풉니다.

노브

F 헤드 감지 지그를 선택합니다.
"소재 두께 + 높이 조절 블록"의 높이에 따라 사용할 헤드 감지 지그를 선택합니다.
소재 두께 + 
높이 조절 블록

사용할 헤드 감지 지그

190 ~ 201 mm Low

201 mm ~ High

Important : 정확한 높이의 헤드 감지 지그를 사용하십시오.

잘못된 지그를 사용하면 헤드가 소재에 부딪혀 마킹 불량이나 부품 손상이 일어날 수 있습니다.

G 헤드 감지 지그의 기다란 홈이 모서리에 있는 노브에 위치하도록 합니다.

기다란 홈

소재 장착

28 Chapter 2 마킹 



H 노브를 조입니다.
지그를 베이스 테이블과 수직이 될 수 있도록 바로 누르면서 고정합니다.

노브(소)

METAZAStudio 창에서 선택한 헤드 감지 홀 위치를 설정합니다.
METAZAStudio 창에서 마우스 오른쪽 버튼을 클릭하고 [Head position detection]-[Back 
left corner]를 클릭하여 헤드 감지 홀 위치를 설정합니다.

I 소재 두께가 50 ~ 190mm인 경우 작업 공간 중앙에 높이 조정 블록을 놓습니다.

J 소재를 장착합니다.

Important!

마킹 할 표면의 이물질을 제거하십시오.

마킹 할  표면에 부착된 이물질을 제거하지 않고 마킹을 수행하면 마킹 품질이 저하 될 수 있습니다.

소재 장착
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K 소재 리테이너 프레임을 소재 폭에 맞게 설정하고 리테이너의 노브를 조입니다.

노브

좁은 소재

노브

이것으로 소재를 장착하는 절차가 완료되었습니다.
 P.32  "마킹 데이터 생성 "

헤드 감지 지그를 우측 전면 코너에 고정하는 경우

헤드 감지 지그를 왼쪽 뒤 모서리에 고정 할 수없는 경우(예 : 테이블의 왼쪽 뒤 모서리에 소재를 장착 
할 때) 이 지그를 오른쪽 전면 모서리에 고정하십시오.

① 오른쪽 전면 모서리에 있는 노브를 풉니다.

노브

소재 장착
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소재가 올바르게 고정되었는지 확인하십시오.

넓은 소재



② 헤드 감지 지그의 기다란 홈이 모서리에 있는 노브에 위치하도록 합니다.

Slit

③ 노브를 조입니다.

지그를 베이스 테이블과 수직이 될 수 있도록 바로 누르면서 고정합니다.

노브

METAZAStudio 창에서 선택한 헤드 감지 홀 위치를 설정합니다.
METAZAStudio 창에서 마우스 오른쪽 버튼을 클릭하고 [Head position detection]-[Front 
right corner]를 클릭하여 헤드 감지 홀 위치를 설정합니다.

소재 장착
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Step 1: 마킹 데이터 생성 준비

절차

A METAZAStudio를 시작합니다.

 P.13  "METAZAStudio 시작하기"

B 를 클릭합니다.

[Select Foil] 화면이 나타납니다.

C [Select Foil] 화면에서 호일을 선택합니다.
호일을 선택하려면 [Use printer driver settings] 확인란의 선택을 취소합니다.  목록에 포함되지 않은 
호일을 사용하려면 호일을 등록 할 수도 있습니다.

 P.83  "호일 등록 및 마킹 강도 조정"

LD 드라이버 설정을 변경하지 않고 사용하려면 [Use printer driver settings] 확인란을 선택합니다.

D [OK]를 클릭합니다.

마킹 데이터 생성
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E [File] → [Preferences]를 클릭합니다.

[Preferences] 화면이 나타납니다.

F 여백을 설정합니다.

① [Margin]을 2mm로 설정합니다.
② [OK]를 클릭합니다.

Important!

평평한 소재를 마킹하려면 여백을 2mm 이상으로 만드십시오. 여백을 2mm 미만으로 설정하면 렌즈가 
소재 가장자리에 부딪혀 손상 될 수 있습니다.

마킹 데이터 생성
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Step 2: 이미지 불러오기

마킹 할 이미지를 불러옵니다.

METAZAStudio에서 지원하는 데이터 형식

• JPEG

• BMP(비트맵)

• Illustrator 버전 7 또는 8에서 만든 AI 또는 EPS

• CorelDRAW 버전 7 또는 8에서 만든 AI 또는 EPS

* Illustrator 및 CorelDraw 파일에는 여러가지 제한사항이 적용됩니다.  자세한 내용은 METAZAStudio
의 온라인 도움말을 참조하십시오.

 METAZAStudio 온라인 도움말 ("Hints and Tips" > "Reusing Existing Data") *현재는 영문만 지원됩니다.

Important : 사진은 이 기기로 인쇄하기에 적합하지 않습니다.

이미지 및 텍스트 데이터를 불러옵니다.

절차

A 를 클릭합니다.

[Import] 화면이 나타납니다.

마킹 데이터 생성

34 Chapter 2 마킹 

B 파일을 엽니다.

① 파일의 위치로 선택합니다.

② [파일 형식]을 [Picture file] 또는 [Adobe Illustrator file]을 선택합니다.

③ 원하는 파일을 선택합니다.

④ [Open]을 클릭합니다.



Memo

크기나 방향을 변경하거나 테두리를 추가하는 등 배치 된 이미지의 배열을 변경할 수 있습니다.

 P. 59 "이미지 처리"

Important!
소재에 구멍이 있는 경우 이미지가 구멍 위에 배치되지 않도록 주의하십시오.  마킹 영역에 구멍을 포함하면 
렌즈가 소재의 가장 자리에 닿으면서 손상 될 수 있습니다.

마킹영역 마킹영역

마킹영역

마킹영역

마킹영역이 구멍 위
에 있는 경우.

소재의 가장자리에 
여백이 없는 경우.

마킹 될 영역이 소재
의 밖으로 벗어나는 
경우.

OK Not OK

2 mm 2 mm 

마킹 데이터 생성
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선택한 이미지를 불러와서 설정한 여백과 함께 표시합니다.



Step 3: 텍스트 입력

마킹 할 텍스트를 입력합니다.

절차

A 를 클릭합니다.

B 텍스트를 입력합니다.

마킹 데이터 생성
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① 마킹 영역을 클릭합니다.
② 텍스트를 입력합니다.
입력 한 텍스트의 크기와 방향을 변경하고 텍스트의 내부를 채울 수 있습니다.

 P. 64 "텍스트 레이아웃에 대한 팁과 요령"



Step 4: 마킹 위치 및 크기 조정

A 기기의 커버를 닫습니다.

B METAZAStudio에서 마킹 데이터를 마우스 오른쪽 버튼으로 클릭하고 [Move LP to the top left
      corner of the object]를 클릭합니다.

Important!

[Move LP to the top left corner of the object] 옵션이 비활성화 된 경우 마킹 데이터에서 모양을 
선택하지 않은 것입니다.  마킹를 선택하고 마우스 오른쪽 단추로 클릭합니다.

C 레이저 포인터가 소재를 조사한 위치를 확인하십시오.

D METAZAStudio에서 마킹 데이터를 마우스 오른쪽 버튼으로 클릭하고 [Move LP to the bottom 
      right corner of the object]를 클릭합니다.

E 레이저 포인터가 재료를 조사한 위치를 확인하십시오.

마킹 데이터의 왼쪽 위 및 오른쪽 아래 위치가 소재의 경계 내에 포함되어 있는지 확인합니다.

F 필요한 경우 METAZAStudio에서 마킹 데이터의 위치와 크기를 변경하십시오.

 P. 60 "이미지의 위치, 크기, 각도 조정" 

 P. 64 "텍스트의 위치, 크기, 각도 변경"

G 원하는 마킹위치로 셋팅 될 때까지 B ~ F 단계를 반복하여 조정합니다.

소재

레이저 포인터

마킹 위치

METAZAStudio

레이저 포인터

마킹 데이터

마킹 데이터 생성
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레이저 포인터 조사가 시작되고 레이저 포인터가 지정된 위치로 이동합니다.

레이저 포인터 조사가 시작되고 레이저 포인터가 지정된 위치로 이동합니다.



Important!

동일한 마킹 데이터를 사용하여 여러 소재 또는 소재의 앞뒤에 연속적으로 마킹하는 경우 소재를 다시 배치 할 
때 레이저 포인터를 사용하여 위치를 조정할 수 없습니다.  처음으로 조정 된 위치를 표시해 놓거나 포지셔닝 
핀을 사용하거나 지그등을 사용하여 동일한 위치에 소재를 배치 할 수 있도록합니다.

포지셔닝 핀

Step 5: 마킹 데이터 저장

마킹 데이터를 파일로 저장합니다.

절차

A 를 클릭합니다. 

B

C

D

마킹 데이터 생성
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[Save As] 화면이 표시 됩니다.

B 파일을 저장할 위치를 지정합니다. 

C 이름을 입력합니다.

D [Save]를 클릭합니다.



호일과 Light-absorbing 필름 장착

A METAZAStudio 창에서 마우스 오른쪽 버튼을 클릭하고 [Move head to the back left corner]를 
      클릭합니다. 

B 소재 위에 호일을 놓습니다.

호일은 앞면과 뒷면이 있습니다.

마킹하려는 호일 색상(광택 표면)이 위를 향하도록 소재 위에 호일을 놓습니다.

라이징 테이블 베이스 테이블 소재 리테이닝 프레임

마킹
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C 필름 프레임 지지대를 테이블의 구멍에 맞춰 삽입합니다.

Important: 호일로 덮인 소재에 light-absorbing 필름을 부착합니다.

     light-absorbing 필름이 소재에 부착되어 있지 않으면 호일이 전사되지 않습니다.

Important: 레이저가 조사되는 위치를 변경하면서 light-absorbing 필름을 사용합니다.

같은 위치를 여러 번 사용하면 빛을 열로 변환하는 성능이 약해집니다.  사용하지 않는 위치가 사용되
도록 위치를 이동하여 light-absorbing 필름을 사용하십시오.  더 사용할 수 있는 위치가 없으면 
light-absorbing 필름을 교체합니다.

 P.52  "Light-absorbing 필름의 수명에 대한 일반 가이드"



마킹

"마킹 데이터 생성"및 "소재 장착"을 완료하면 마킹이 시작됩니다.
 P.32  "마킹 데이터 생성", P.17  "소재 준비"

절차

A 레버가    로 설정되어 있는지 확인하십시오. 

 P. 82 "마킹 압력 조정"

레버

B 커버를 닫습니다.

C METAZAStudio 창에서 마우스 오른쪽 버튼을 클릭하고 [Head position detection]-[Back left 
      corner] 또는 [Front right corner]를 클릭합니다.

두께가 14mm 이상인 소재로 라이징 테이블을 사용하는 경우 
헤드 감지 위치를 왼쪽 뒤 모서리로 설정해야합니다.  앞 우측 모서리 위치에서 감지하면 헤드의 간섭이 
발생할 수 있습니다.

헤드 감지 홀(왼쪽뒤 모서리)

두께가 14mm 미만인 소재로 라이징 테이블을 사용하는 경우 
사용할 라이징 테이블의 헤드 감지 홀에 따라 감지 위치를 선택하십시오.

헤드 감지 홀
(왼쪽뒤 모서리)

헤드 감지 홀
(앞 우측 모서리)

마킹
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라이징 테이블을 사용하지 않을 때
헤드 감지 지그가 부착 된 실제 위치에 따라 위치를 선택하십시오.

D  를 클릭합니다.
[Print] 화면이 나타납니다.

Printer name DGSHAPE LD-300

Imprint range
주로 변수 데이터 마킹에 이 옵션을 사용합니다.(일반적으로 [All]이 선택됩니
다.)  마킹 할 레코드 *를 제한하려면 마킹 할 레코드(페이지)를 지정합니다.  
예를 들어 2 ~ 5 번째 레코드만 마킹하려면 [Page]를 선택하고 "2"에서 "5"까
지 지정합니다.

Copies
여러 위치에 동일한 소재를 마킹하는 경우 사본 수를 지정하십시오.  예를 들어, 
소재의 앞면과 뒷면을 마킹하려면 복사 매수로 "2"를 지정하십시오.

* 레코드 : 이것은 변수 데이터 마킹을 위해 데이터에 포함 된 개별 데이터를 나타냅니다.
 P.78  "변수 데이터 생성"

F [OK]를 클릭합니다.
마킹이 시작됩니다.

마킹
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E 아래 환경 설정을 지정하고 확인하십시오.

Foil
호일을 선택하십시오.  새 마킹 데이터를 생성 할 때 선택한 사항은 호일 설정에 
반영됩니다.



Memo : 여러 사본 또는 레코드 마킹

Important : 마킹중에는 절대로 커버를 열지 마십시오.

마킹 중에 커버를 열면 마킹이 중지되어 올바르게 마킹 할 수 없게됩니다.

 P.20  "소재 장착(소재 두께 : 0 ~ 26mm)" 

 P.22  "소재 장착(소재 두께 : 24 ~ 50 mm)" 

 P.26  "소재 장착(소재 두께 : 50 ~ 216 mm)"

Important!

동일한 마킹 데이터를 사용하여 여러 소재 또는 소재의 앞뒤에 연속적으로 마킹하는 경우 소재를 다시 설
정할 때 레이저 포인터를 사용하여 위치를 조정할 수 없습니다.  처음으로 조정 된 위치를 표시해 놓거나 
포지셔닝 핀을 사용하거나 지그 등을 사용하여 동일한 위치에 소재를 설정할 수 있도록합니다.

포지셔닝 핀

H 커버를 닫습니다.

I [OK]를 클릭합니다.

다음 페이지의 마킹이 시작됩니다.

마킹
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마킹이 시작되면 다음 메시지 중 하나가 표시됩니다.  마킹이 완료 될 때까지 기다린 후 다음 단계로 
이동합니다.

G 마킹이 완료되면 소재를 교체하거나 방향을 변경하십시오.



표시된 변수데이터의 레코드만 마킹

마킹
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를 클릭합니다.
[Print] 화면이 나타납니다.  METAZAStudio에 표시되는 레코드의 번호(페이지 번호)는 [Print Range]
에서 페이지로 지정됩니다.  필요에 따라 [Foil] 및 [Copies]를 지정하고 [OK]를 클릭하여 마킹을 시작
합니다.



Step 1: 마킹 작업 중지

A 전원 / 이동 버튼을 1 초 이상 누릅니다.

Memo

마킹이 일시 중지되면 헤드는 그 자리에서 멈춥니다.  다음에 전원을 켤 때 헤드가 왼쪽 뒤의 대기 위치로 
이동합니다.

마킹 작업 중지
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전송 된 마킹 데이터가 취소되는 동안 표시등이 천천히 깜박입니다.  표시등이 꺼지고 전원이 꺼집니다.



Step 2: 마킹 대기열에서 데이터 삭제

절차

A 프린터 아이콘을 표시합니다.

Windows 10
① 컴퓨터에서 [시작] 메뉴를 클릭합니다.
② [Windows 시스템]을 클릭하고 [제어판]을 클릭합니다.
③ [장치 및 프린터 보기]를 클릭합니다.

Windows 8.1
① 컴퓨터의 [시작] 메뉴를 마우스 오른쪽 버튼으로 클릭합니다.
② [제어판]을 클릭합니다.
③ [장치 및 프린터]를 클릭합니다.

Windows 7
① [시작] 메뉴를 클릭합니다.
② [장치 및 프린터]를 클릭합니다.

B [DGSHAPE LD-300] 아이콘을 더블 클릭합니다.

C [프린터] 메뉴에서 [모든 문서 취소] (또는 [인쇄 문서 제거])를 클릭합니다.

마킹 작업 중지
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마킹 작업 중지
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D 그림과 같은 메시지가 나타나면 [예]를 클릭합니다.
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일일 유지보수에 대한 주의 사항

경고 수리, 부품 교체 및 기타 유사한 작업 중 사용자 설명서에 기록되지 않은 작업을 직접 수행

하지 마십시오.
공인 Roland DG Corporation 대리점에 문의하십시오.

이 지침을 따르지 않으면 기기가 갑자기 움직여 부상을 입을 수 있습니다.

• 이 기기는 정밀 장치이며 먼지와 오염 물질에 민감합니다.  매일 청소를 수행하십시오.
• 가솔린, 알코올 또는 시너와 같은 용제는 절대 사용하지 마십시오.
• 기기에 오일이나 윤활유를 바르지 마십시오.
• 기기에 실리콘 물질 (오일, 그리스, 스프레이 등)을 바르지 마십시오.  그럴 경우 스위치 접촉 불량이

발생할 수 있습니다.

기기 청소

• 물에 적셔 잘 짠 천을 사용하여 부품을 부드럽게 닦아서 청소하십시오.
• 커버 표면은 쉽게 긁힐 수 있으므로 부드러운 천을 사용하십시오.

접착 시트 청소

접착 시트에 먼지 등이 쌓이면 시트의 접착력이 감소하여 소재를 고정하기 어렵습니다.  접착력이 
감소한 경우 접착 시트를 세척하십시오.

접착시트

세척 방법

접착 시트를 물에 담그고 표면을 부드럽게 쓰다듬어 씻어냅니다.  접착 시트의 오염이 심한 경우 희석 
된 중성 세제를 사용하여 세척하십시오.  모든 세제가 완전히 제거될 때까지 물로 충분히 헹구십시오.

Important!

다음 지침을 반드시 준수하십시오.  그렇지 않으면 접착 시트의 표면이 손상되어 접착 성이 저하 될 수 
있습니다.

• 수세미나 스폰지를 사용하여 접착 시트를 문지르지 마십시오.
• 접착 시트를 세탁 할 때 늘리거나 구부리지 마십시오.

일일 유지보수
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경고 가솔린, 알코올, 시너 또는 기타 가연성 물질을 사용하지 마십시오.
화재가 발생할 수 있습니다.

경고 모든 전원 스위치를 끈 상태에서 작업을 수행하십시오.



건조 방법

직사광선을 피해 완전히 건조 시키십시오.

필름 프레임 청소

필름 프레임의 접착 시트에 먼지 등이 쌓이면 시트의 접착력이 감소하여 light-absorbing 필름을 
고정 할 수 없습니다.  접착력이 감소한 경우 필름 프레임의 접착 시트를 세척하십시오.

접착 시트

세척 방법 

접착 시트를 물에 담그고 표면을 부드럽게 쓰다듬어 씻어냅니다.  접착 시트의 오염이 심한 경우 희석 
된 중성 세제를 사용하여 세척하십시오.  모든 세제가 완전히 제거될 때까지 물로 충분히 헹구십시오.

Important!

다음 지침을 반드시 준수하십시오.  그렇지 않으면 접착 시트의 표면이 손상되어 접착 성이 저하 될 수 
있습니다.

건조 방법 

직사광선을 피해 완전히 건조 시키십시오.

일일 유지보수
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• 수세미나 스폰지를 사용하여 접착 시트를 문지르지 마십시오.
• 접착 시트를 세탁 할 때 늘리거나 구부리지 마십시오.



레이저 포인터 위치 조정

이 기기로 METAZAStudio에 연결된 레이저 포인터의 조사 위치를 보고 마킹 위치를 결정합니다. 실제
마킹 위치가 레이저 포인터의 조사 위치에서 벗어나는 경우 아래 표시된 방법으로 조사 위치를 조정합니
다.

절차

A LD-300 Head Manager를 시작 합니다.

 P.10  "소프트웨어 시작하기"

B [Adjust LP Position]를 클릭합니다.

[Adjust LP Position] 창이 표시됩니다.
화면의 지시에 따라 조정하십시오.

 P.92  "레이저 포인터 위치 조정을 실패하는 경우(Head Manager)"

준비 할 소재

• 평평한 마킹가능한 표면이 있는 소재(곡면이 아닌 소재)
• 이 기기로 마킹 될 수있는 소재

 P.17  "소재 준비"

• 마커가 포함 된 크기의 소재 (30mm × 30mm 이상)

창이 닫힙니다.

조정
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C 완료되면          를 클릭합니다.



소모품 교체

렌즈 수명 확인

렌즈는 소모품입니다.  렌즈의 수명이 다하면 교체하십시오.

렌즈의 수명에 대한 일반 가이드

권장 교체 시간은 약 500시간 사용 후입니다.  
렌즈의 수명을 나타내는 메시지가 METAZAStudio에 나타납니다.

[OK]를 클릭하면 메시지가 사라집니다.  [Details]를 클릭하면 LD-300 Head Manager가 나타납니다.

렌즈 상태를 확인하는 방법

LD-300 Head Manager를 사용하여 렌즈의 상태를 확인할 수 있습니다.

절차

A LD-300 Head Manager를 시작 합니다.

 P.10  "소프트웨어 시작하기"

B 기기의 전원을 켭니다.

 P.9  "전원켜기"

렌즈 사용량이 창에 표시됩니다.  레벨 표시기는 마킹이 수행됨에 
따라 조금씩 증가합니다.

클릭하면 화면이 새로고침되어 최신 정보가 표시됩니다.
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Memo

LD-300 Head Manager의 [The amount of Lens usage] 표시기는 렌즈 사용량을 나타냅니다.   
다음과 같은 경우 렌즈를 교체해야합니다.

Light-absorbing 필름 교체

동일한 위치를 여러 번 사용하면 light-absorbing 효과가 감소합니다.   light-absorbing 필름의 사용하
지 않은 위치가 사용되도록 위치를 이동하여 사용하십시오.  사용할 수 있는 위치가 없으면 light-
absorbing 필름을 교체하십시오.

Light-absorbing 필름의 수명에 대한 일반 가이드

light-absorbing 필름은 반복 사용으로 인한 열 발생으로 주름과 구부러짐이 나타나거나 하얗게 변하면 
수명이 다한 것입니다.  light-absorbing 필름이 다음 그림과 같은 상태이면 위치를 이동하거나 light-
absorbing 필름을 교체하십시오.

백화 현상이 나타나는 부분은 더 이상 빛을 흡수 할 수 
없으므로 마킹에 사용할 수 없습니다.

소모품 교체
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• 표시기가 빨간색으로 표시됩니다.

• 표시기가 빨간색으로 표시되지 않지만 마킹 품질이 좋지 못한 경우.

마모 된 렌즈가 마킹 품질 저하 및 불균일한 마킹 결과의 유일한 원인은 아닙니다.  문제의 원인을 찾으

려면 다음 페이지를 참조하십시오.  마모 된 렌즈가 문제의 원인일 가능성이 있는 경우 렌즈를 새 것으

로 교체하십시오.

" P.91  "마킹 된 이미지의 품질이 좋지 않은 경우(고르지 않거나 변형 된 경우)"

* 교체용 렌즈는 옵션으로 판매됩니다.  구매 정보는 공인 Roland DG Corporation 대리점에 문의하
거나 Roland DG Corporation 웹 사이트 (http://www.rolanddg.kr/)를 방문하십시오.

* 렌즈 교체 방법은 교체 렌즈에 포함 된 설명서를 참조하십시오.



Light-absorbing 필름 교체 방법

절차

접착 시트

소모품 교체
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A 테이블에서 필름 프레임을 제거합니다.

B 접착 시트 표면이 위를 향하도록 필름 프레임의 방향을 조정합니다.

C 필름 프레임에서 light-absorbing 필름을 떼어냅니다.



Not  OKOK

Light-absorbing 필름 

Important!

 P.49  "필름 프레임 청소"

소모품 교체
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D 새로운 light-absorbing 필름을 필름 프레임에 부착합니다.

필름이 필름 프레임의 가장자리 밖으로 벗어나지 않도록 필름 프레임의 모양에 맞춥니다.

light-absorbing 필름은 재료면과 렌즈면을 갖고 있습니다.  필름을 필름 프레임의 모양과 일치시켜 필름의 
올바른 면이 위를 향하여 부착되도록 합니다.  잘못된 면이 위를 향하도록 기기를 사용하면 오작동이 발생할 
수 있으므로 필름을 부착 할 때 주의 하십시오.

Memo

접착 시트가 필름 프레임에 부착되는 접착력이 감소한 경우 접착 시트를 청소하십시오.
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METAZAStudio 창에서 필름 프레임의 설정 위치를 확인하면서 마킹 데이터를 생성합니다.

절차

A 를 클릭합니다.

[Material] 패널이 나타납니다.

① [Group]에서 [Material]을 선택합니다.

② [Icon]을 선택합니다.

③ [LD-300_FilmFrame]을 클릭합니다.

④ 를 클릭합니다.

1

2

3

4

[Material Size] 화면이 나타납니다.

필름 프레임에 맞는 데이터 생성
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B 필름 프레임의 모양을 선택합니다.



⑤ [OK]를 클릭합니다.

설정을 변경하지 마십시오.  실수로 변경 한 경우 아래 표시된 설정으로 되돌립니다.

Width: 305 mm

Height: 230 mm

5

필름 프레임에 맞는 데이터 생성
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필름 프레임이 표시됩니다.



C [File] → [Preferences]를 클릭합니다.

[Preferences] 화면이 표시됩니다.

D 여백을 설정합니다.

① [Margin]을 2mm로 설정합니다.
② [OK]를 클릭합니다.

필름 프레임에 맞는 데이터 생성
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이미지의 필요한 부분만 유지(트리밍)

METAZAStudio는 원본 이미지를 잘라 불필요한 영역을 제거하고 필요한 부분만 남겨놓을 수 있습니다.  
이 작업을 "트리밍"이라고합니다.

절차

A 이미지를 불러옵니다.

 P.34  "Step 2: 이미지 불러오기"

B 이미지를 선택합니다.

①       를 클릭합니다.

② 이미지를 클릭합니다.

이미지 주위에 8 개의 트리밍 바가 나타납니다.

C 이미지를 자릅니다.
마킹하려는 영역을 트리밍하려면 트리밍 바를 드래그하십시오.

트리밍 포인터

이미지 처리

59Chapter 4 세부작동/설정 



이미지의 위치, 크기, 각도 조정

절차

      를 클릭합니다. 

이미지 위치 조정 

① 이미지를 클릭합니다.
(■)가 이미지의 네 모서리에 나타납니다.

② 이미지를 드래그하여 위치를 조정합니다.

이미지 크기 조정 
① 이미지를 클릭합니다.

(■)가 이미지의 네 모서리에 나타납니다.

② 이미지의 네 모서리에있는 핸들을 드래그하여 크기를 조정합니다.

핸들

이미지 처리
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이미지 각도 조정
① 이미지의 네 모서리에 핸들이있는 상태에서 이미지를 두 번 클릭합니다.

네 모서리의 핸들 모양이 (●)로 변경됩니다.
② 포인터를 핸들로 정렬합니다.

모양이 회전 포인터로 변경됩니다.
③ 핸들을 끌어 이미지의 각도를 조정합니다.

Memo

• 핸들을 드래그 시 키보드의 "SHIFT" 키를 누르고 드래그하면 각도가 한 번에 45 도씩 변경됩니다.
이 방법을 사용하면 정확하게 90도 회전을 수행하려는 경우 편리 할 수 있습니다.

• 각도가 변경된 이미지에 대해서는 트리밍을 수행 할 수 없습니다. 트리밍을 수행하려면 먼저 이미
지를 원래 각도로 되돌립니다.

이미지 처리
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프레임에 이미지 삽입

이미지 주위에 프레임을 배치하여 마킹 데이터의 배열을 변경할 수 있습니다.  METAZAStudio의 
"library"에 등록 된 프레임을 사용합니다.  library에는 사전 등록 된 여러 프레임이 포함되어 있으며 
새 프레임을 등록 할 수 있습니다.

 METAZAStudio 온라인 도움말 ("Hints and Tips" > "Making Use of Library") *현재는 영문만 지원 됩니다.

절차

A 를 클릭합니다.
[Library] 창이 나타납니다.

B 프레임을 삽입합니다.

① [Group]에서 [Frame]을 선택합니다.
② [Icon]을 선택합니다.
③ [18] 프레임을 클릭합니다.
④ 를 클릭합니다.

창에 프레임이 삽입됩니다.

이미지 처리
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C 프레임의 크기와 위치를 조정하십시오.

핸들

이미지 처리
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프레임의 크기가 소재보다 작으면 그림과 같은 결과가됩니다.  조정 방법은 이미지의 위치 및 크기를 
조정하는 방법과 동일합니다.

 P.60  "이미지의 위치, 크기, 각도 조정"



텍스트 레이아웃에 대한 팁과 요령

텍스트의 위치, 크기, 각도 변경

이미지 처럼 배치 된 텍스트의 위치, 크기 및 각도를 변경할 수 있습니다.

절차

A 텍스트를 입력합니다.

 P.36  "Step 3: Text입력"

B 텍스트 위치를 조정합니다.
① 를 클릭합니다.
② 레이아웃 된 텍스트를 클릭합니다.

텍스트 주위에 8 개의 핸들이 나타납니다.
③ 텍스트를 드래그하여 위치를 조정합니다.

C 프레임의 크기를 조정하십시오.
핸들을 드래그하여 크기를 조정하십시오.
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D 텍스트의 각도를 조정합니다.

① 텍스트를 클릭하고 네 모서리의 핸들 모양이 [●]로 바뀔 때까지 마우스 버튼을 길게 누릅니다.

② 핸들로 포인터를 정렬합니다.

모양이 회전 포인터로 변경됩니다.

③ 핸들을 드래그하여 텍스트 각도를 변경합니다.

Memo

핸들을 드래그 시 키보드의 "SHIFT" 키를 누르고 드래그하면 각도가 한 번에 45도씩 변경됩니다.
이 방법을 사용하면 정확하게 90도 회전을 수행하려는 경우 편리 할 수 있습니다.

팬 레이아웃에 텍스트 정렬

A 텍스트를 입력합니다.

 P.36  "Step 3: 텍스트 입력"

B 를 클릭합니다.

[Properties] 화면이 나타납니다.
입력 한 문자가 포함 된 텍스트 상자를 선택하지 않으면       이 비활성화되어 클릭할 수 없습니다.
텍스트 상자를 선택해야합니다.

텍스트 레이아웃에 대한 팁과 요령
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C 텍스트를 배치합니다.
① Format 탭을 클릭합니다.
② [Align with Curve] 확인란을 선택합니다.
③ [OK]을 클릭합니다.

텍스트 레이아웃이 부채꼴 모양으로 변경됩니다.

텍스트 레이아웃에 대한 팁과 요령
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도형을 따라 텍스트 레이아웃

그리기 도구를 사용하여 만든 모양을 따라 텍스트를 배치합니다.

절차

A 모양을 만듭니다.
① 그리기 도구를 클릭합니다.

이 예에서는        을 사용합니다.
② 편집 창에서 소재에 모양을 만듭니다.

 METAZAStudio 온라인 도움말("Commands" - "Toolbar Buttons")

그리기 도구

B 를 클릭합니다.
만든 도형의 윤곽선 근처에 포인터를 놓으면 포인터 아래에         가 나타납니다. 가 나타나면
클릭합니다.

텍스트 레이아웃에 대한 팁과 요령
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C 텍스트를 입력합니다.

 P.36  "Step 3: 텍스트 입력"
텍스트가 모양을 따라 배치됩니다.

Important!

통합 폴리 라인의 레이아웃은 불가능합니다.
 METAZAStudio 온라인 도움말("Commands" > "[Object] menu" > "Convert to Polyline," "Integrate Polylines")

텍스트 채우기 

텍스트를 채우는 방법에는 [Fill]과 [Island Fill] 두 가지가 있습니다.  원하는 방법을 선택하십시오.

Fill
공백없이 마킹이 수행됩니다.

Island Fill
인접한 채우기 선 사이의 간격을 지정할 수 있습니다.

A 텍스트를 입력합니다.

 P.36  "Step 3: 텍스트 입력"

텍스트 레이아웃에 대한 팁과 요령

68 Chapter 4 세부작동/설정 



B 를 클릭합니다.

[Properties] 화면이 나타납니다.
입력 한 문자의 텍스트 상자를 선택하지 않으면       을 선택할 수 없습니다.  텍스트 상자를 선택해야 
합니다.

텍스트 레이아웃에 대한 팁과 요령
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C 채우기 설정 구성

① [Fill and Contour] 탭을 클릭합니다.

② [Fill] 확인란을 선택합니다.

③ [Fill] 또는 [Island Fill]를 선택합니다.

[Island Fill]을 선택한 경우 pitch*도 입력해야 합니다.

* pitch : 채우기 라인의 간격

④ [OK]를 클릭합니다.

텍스트가 채워집니다.



스트로크 문자 및 SFEdit2 정보

스트로크 문자란?

스트로크 문자는 기본 글꼴에서 중심선을 추출하여 만든 라인 문자입니다.

SFEdit2 란?

SFEdit2는 스트로크 문자 글꼴을 만들고 편집하는 프로그램입니다.  모든 스트로크 문자는 폴리 라인과 
선으로 구성되어 있으므로 앵커 포인트를 추가 또는 삭제하고 선분을 추가 할 수 있습니다. 
 METAZAStudio에서는 SFEdit2를 사용하여 만들고 편집 한 스트로크 문자를 사용할 수 있습니다.

스트로크 문자 글꼴 생성 / 편집
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SFEdit2 창

No. 이름 기능의 개요

① 메뉴바 
SFEdit2에 대한 다양한 명령을 실행합니다.

 SFEdit2 도움말 ("Commands") *현재는 영문만 지원됩니다.

② 툴바
툴바에는 [Open...] 및 [Save]와 같은 SFEdit2 명령을 실행하기 위한 버튼이 
있습니다.

 SFEdit2 도움말 ("Commands" - "Toolbar buttons")

③ 상태바
포인터를 도구 모음 버튼으로 이동하거나 메뉴 명령을 가리키면 버튼 또는 
명령에 대한 간략한 설명이 표시됩니다.

④ 캐릭터 목록 모든 스트로크 문자  목록이 표시됩니다.  문자를 편집하려면 클릭하십시오.

⑤ 기준선
텍스트 문자열을 가로로 정렬하기위한 참조선입니다.  텍스트를 가로로 쓸 때 
인접 문자의 기준선이 가로선을 따라 정렬되어 불균일 함이 없습니다.

⑥ 텍스트 상자

⑦ 기본 글꼴 텍스트
스트로크 문자 를 편집하기 위한 초안으로 표시됩니다.  기본 글꼴은 스트로크 
문자의 디자인 기반 역할을합니다.

⑧ 스트로크 문자 

기본 글꼴 텍스트에서 중심선을 추출하여 만든 라인문자 입니다.  모든 스
트로크 문자는 앵커 포인트 추가 또는 삭제, 선분 추가 등을 통해 편집 할 
수 있습니다.

 SFEdit2 도움말("Operation Procedures" > "Step 2: Edit the shape of character")

스트로크 문자 글꼴 생성 / 편집
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텍스트를 둘러싸는 상자입니다.  상자의 크기는 기본 글꼴 유형 및 문자에 따라 
다릅니다.  일반적으로 상자 내부에 맞도록 텍스트를 만들어야합니다.



스트로크 문자 글꼴 만들기

스트로크 문자 글꼴을 만들고 저장하는 방법은 다음과 같습니다.

절차

A METAZAStudio를 시작합니다.

B [Edit] → [Stroke Font] → [Run SFEdit2…]를 클릭합니다.

SFEdit2 이 시작 됩니다.

C [File] → [New…]를 클릭합니다.
[기본 글꼴 선택] 화면이 나타납니다.

D 스트로크 문자를 만듭니다.

① 만들 스트로크 문자 글꼴의 기본으로 사용할 글꼴을 선택합니다.

② [OK]를 클릭합니다.

스트로크 문자 글꼴 생성 / 편집
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스트로크 문자 글꼴이 자동으로 생성됩니다.

E 를 클릭합니다.

[Save] 화면이 나타납니다.

F 생성된 스트로크 문자 글꼴의 이름을 입력하고 저장합니다.
① 생성 된 스트로크 문자의 이름을 입력합니다.
기본 글꼴 이름을 기반으로 이름을 지정하면 나중에 새 이름을 쉽게 식별 할 수 있습니다.  예를들어
"MS P Gothic_SF"가 입력됩니다.

② [OK]를 클릭합니다.

생성 된 스트로크 문자의 글꼴이 저장됩니다.

G           를 클릭합니다. 

스트로크 문자 글꼴 생성 / 편집
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입력 한 문자를 스트로크 문자 글꼴로 변경

다음 작업 중 하나를 미리 완료해야 합니다.

SFEdit2를 설치하기 전에 스트로크 문자 글꼴을 만듭니다.

설치 중에 그림과 같은 창이 나타납니다.  설치시 스트로크 문자 글꼴을 만들지 않은 경우 SFEdit2를 

다시 설치하고 스트로크 문자 글꼴을 만듭니다.
 P.94  "소프트웨어와 설명서를 별도로 설치"

새 스트로크 문자 글꼴을 만듭니다.

 P.72  "스트로크 문자 글꼴 만들기"

절차

A METAZAStudio에 문자를 입력합니다.

 P.36  "Step 3: 텍스트 입력"

B 를 클릭합니다.

[Properties] 화면이 나타납니다.
텍스트 상자를 선택하지 않으면       을 선택할 수 없습니다.  텍스트 상자를 선택합니다.

스트로크 문자 글꼴 생성 / 편집
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C 스트로크 문자 글꼴을 선택합니다.

① [Format] 탭을 클릭합니다.

② [Stroke]를 선택합니다.

[Font] 옵션이 스트로크 문자로 제한됩니다.

③ 스트로크 문자 글꼴을 선택합니다.

④ [OK]를 클릭합니다.

입력 된 문자는 스트로크 문자로 변경됩니다.  ③에서 선택한 스트로크 문자 글꼴은 스트로크 문자에 
사용됩니다.

스트로크 문자 글꼴 생성 / 편집

75Chapter 4 세부작동/설정 



스트로크 문자 편집

절차

A 입력 문자를 스트로크 문자로 변경합니다.

 P.74  "입력 된 문자를 스트로크 문자 글꼴로 변경 "

B 스트로크 문자 편집을 시작합니다.

① 를 클릭합니다.
② 편집 할 스트로크 문자를 클릭합니다.
스트로크 문자 주위에 핸들이 나타납니다.

③ [Edit] → [Stroke Font] → [Edit Stroke…]를 클릭합니다.

SFEdit2 이 시작됩니다.

C 문자 목록에서 편집 할 스트로크 문자를 클릭합니다.
편집하려는 스트로크 문자가 가상 본문에 표시되고 스트로크 문자를 편집 할 수 있습니다.  스트로크 
문자의 위치와 모양을 변경합니다.

 SFEdit2 도움말("Editing Polylines")

캐릭터 목록

스트로크 문자 글꼴 생성 / 편집
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D SFEdit2를 닫습니다.
①      를 클릭합니다.
         선택한 스트로크 문자 글꼴을 편집한 세부 정보로 덮어 씁니다.

② 를 클릭합니다.

SFEdit2가 닫힙니다.

스트로크 문자 글꼴 생성 / 편집
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편집된 세부 사항은 스트로크 문자에 반영됩니다.



변수 데이터 생성

데이터베이스 파일을 사용하여 CSV 파일을 만들 수 있습니다.  CSV 파일 작성에 대한 정보는 데이터베
이스 관리자에게 문의하십시오.

Step 1: 변수 필드 만들기

A METAZAStudio를 시작합니다.

 소프트웨어 시작 방법은 설정 가이드를 참조하십시오.

METAZAStudio가 이미 실행 중이면      을 클릭하십시오.

[Select Foil] 화면이 나타납니다.

B [Select Foil] 화면을 사용하여 호일을 선택합니다.

호일을 선택하려면 [Use printer driver settings] 확인란의 선택을 취소합니다.  목록에 포함되지 않은 
호일을 사용하려면 호일을 등록 할 수도 있습니다.

 P.83  "호일 등록 및 마킹 강도 조정"

LD 드라이버 설정을 변경하지 않고 사용하려면 [Use printer driver settings] 확인란을 선택합니다.

C [OK]를 클릭합니다.

78 Chapter 4 세부작동/설정

마킹 데이터의 일부를 변경하여 각 소재에 다른 내용을 마킹하는 것을 "변수 데이터 마킹"이라고합니
다.  변수 데이터 마킹을 수행 할 때 소재를 장착 할 때마다 새 데이터를 만들 필요가 없습니다.  중단없
이 다른 데이터를 계속 인쇄 할 수 있습니다.

Important!

 다양한 데이터를 사용한 연속 마킹은 구성과 크기가 동일한 소재로만 수행 할 수 있습니다.

변수 데이터 마킹을 수행하려면 CSV 파일이 필요합니다.

Memo : 변수 필드란?

변수 필드는 텍스트를 배치 할 수있는 프레임 입니다.  변수 데이터 마킹을 사용하여 마킹하면 변수 필드 
내의 데이터가 다른 데이터로 대체되며 마킹 됩니다.

절차



D 프레임 삽입 아이콘을 클릭합니다.

     을 클릭하고       를 클릭하십시오.

E METAZAStudio의 작업 영역 *에서 마우스를 대각선으로 아래로 드래그 합니다.
      (마우스 왼쪽 버튼을 누른 채 이동).

작업 영역

F  를 클릭합니다.
[Properties] 화면이 나타납니다.

변수 데이터 생성
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텍스트를 배치 할 수있는 변수 필드가 생성됩니다.

* 작업 영역 = 화면의 검은 색 영역

변수 필드가 선택되지 않은 경우       을 클릭 할 수 없습니다.       를 클릭 할 수없는 경우       을 
클릭하고 변수 필드를 클릭(선택)합니다.



각 설정에 대한 자세한 내용은 METAZAStudio의 도움말 ("Commands" > "[Object] menu" > 
"Properties" > "[Properties] dialog box")을 참조하십시오.

 소프트웨어 도움말을 표시하는 방법은 설정 가이드를 참조하십시오.

변수 데이터 생성
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G 변수 필드의 크기 및 기타 설정을 구성합니다.

H 설정을 구성한 후 [OK]을 클릭합니다.

I 변수 필드를 마킹 위치로 이동합니다.

① 를 클릭합니다.
② 변수 필드를 그래그하여 이동합니다.



Step 2: 변수 필드 안에 텍스트 배치

절차

A [Load CSV File]를 클릭합니다.
[Open...] 화면이 나타납니다.

[Variable Printing] 창이 표시되지 않으면       을 클릭합니다.

변수 데이터 생성
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B CSV 파일을 선택하고 [Open]를 클릭합니다.

선택된 CSV 파일을 METAZAStudio로 가져옵니다.

C 가져온 CSV 파일의 열 제목을 변수 필드로 드래그합니다.
변수 필드에 텍스트가 표시됩니다.

          을 클릭하면 각 페이지를 차례로 표시 할 수 있습니다.  변수 필드의 크기나 위치를 변경
하려면 [Properties]화면(      를 클릭)을 열고 설정을 변경합니다.



마킹 조건 조정

마킹 압력 조정

마킹 중에 헤드가 소재에 적용되는 압력(마킹 압력)과 일치하도록 레버 설정을 변경합니다.

	

첫 번째 마킹을 위해 레버를이 위치로 설정합니다.

• 또는

숫자가 높을수록 소재에 적용되는 마킹 압력이 강해집니다.  더 높은 숫자를 사용하면    설정보다

마킹이 더 잘됩니다.  부드러운 소재 또는 표면이 울퉁불퉁 한 소재에 대해    설정으로 선면한 마킹

이 수행되지 않은 경우 레버를 이 위치로 설정 한 상태에서 마킹을 시도하십시오.

그러나 마킹 압력이 높을수록 마킹 마크가 소재에 남게되고 호일의 광택이 손실 될 가능성이 커집

니다.  폐목재 또는 유사한 소재에 테스트 마킹을 수행하여 적절한 마킹 압력을 결정합니다.

o 올리기 : 레버를 올리기만 하면 됩니다.
o 내리기 : 레버를 살짝 누르면서 내립니다.

레버
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호일 등록 및 마킹 강도 조정

이 기기를 사용하면 사용 된 소재의 호일과 일치하는 마킹 파워를 사용하여 마킹하면 더 높은 품질의 마
킹 결과를 얻을 수 있습니다.  LD 드라이버에는 여러 호일과 일치하는 미리 구성된 사전설정이 있지만 호
일과 최적 설정을 직접 등록 할 수도 있습니다.  더 나은 마킹 결과를 얻기위해 직접 등록한 호일의 마킹
파워를 조정할 수도 있습니다.

절차

A [LD 드라이버 인쇄 기본 설정] 화면을 표시합니다.

" [LD 드라이버 인쇄 기본 설정] 화면을 표시하는 방법은 설정 가이드를 참조하십시오.

B 마킹 모드를 선택합니다.

① [Image Correction] 탭을 클릭합니다.

② [Foil] 옵션을 선택합니다.(a ~ d 설정)

③ 마킹 모드로 [Text] 또는 [Other]를 선택합니다.

Text 명확한 윤곽선으로 텍스트 및 기타 이미지를 마킹하려는 경우.

Other

 LD Driver 온라인 도움말("[Image Correction] tab")

④ [Details]을 클릭합니다.

[Details] 창이 나타납니다.

마킹 조건 조정
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해상도 기능(또는 도트 해상도의 정도)을 변경하여 도트 밀도의 차이를 기준

으로 표현을 만들거나 해상도를 높여 작은 텍스트 나 패턴의 거칠기를 개선

하려는 경우에 선택합니다.  [Details]를 클릭하여 이미지 해상도 및 기타 설

정을 지정합니다.



① 등록하려는 호일의 이름을 입력합니다.

② 속도와 마킹 압력을 입력합니다.
마킹 결과는 호일에 따라 다릅니다.  호일과 일치하도록 조정하십시오.

 LD Driver 온라인 도움말([Image Correction] tab > [Details] dialog box)

Speed

Power--MIN 이미지의 가장 어두운 부분(회색 부분)의 마킹 압력을 설정합니다.

Power--MAX 이미지의 가장 밝은 부분(흰색 부분)의 마킹 압력을 설정합니다.

Vector--Power 라인에 대한 마킹 압력의 최대 값을 설정할 수 있습니다.

③ [Advanced]를 선택합니다.

[Advanced]는 B 단계의 ③에서 [Other]를 선택한 경우에만 사용할 수 있습니다.

 LD Driver 온라인 도움말([Image Correction] tab > [Details] dialog box)

OutputResolution
인치당 도트 수를 지정할 수 있습니다.  포인트 수가 많을 수록 이미지가 더 
선명해집니다.

Drafting
이미지를 보기 쉽게하기 위해 한 점씩 이미지 정보를 건너 뛸 수 있습니다.  
작은 텍스트나 선의 경우 정보를 건너뛰면 눈에 띄게 거칠게 마킹 될 수 있습
니다.  그런경우 이 옵션을 "OFF"로 설정하십시오.

④ [OK]를 클릭합니다.

[Details] 창이 닫힙니다.

마킹 조건 조정
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C 자세한 마킹 모드 설정을 구성합니다.

마킹 속도를 변경하십시오.  이미지(래스터) 마킹 및 라인의 마킹 속도가 지정된 

값으로 설정됩니다.  마킹 속도는 최대 48mm/초 입니다.



기본 드라이버 설정 변경

절차

A 프린터 아이콘을 표시합니다.

Windows 10

① 컴퓨터에서 [시작] 메뉴를 클릭합니다.

② [Windows 시스템]을 클릭하고 [제어판]을 클릭합니다.

③ [장치 및 프린터 보기]를 클릭합니다.

Windows 8.1

① 컴퓨터의 [시작] 메뉴를 마우스 오른쪽 버튼으로 클릭합니다.

② [제어판]을 클릭합니다.

③ [장치 및 프린터]를 클릭합니다.

Windows 7

① 컴퓨터에서 [시작] 메뉴를 클릭합니다.

② [장치 및 프린터]를 클릭합니다.

B [DGSHAPE LD-300] 아이콘을 마우스 오른쪽 버튼으로 클릭하고 [인쇄 기본 설정]을 클릭합니다.
LD 드라이버 인쇄 기본 설정 창이 나타납니다.  필요에 맞게 설정을 변경하십시오.
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C 설정을 구성한 후 [확인]을 클릭합니다.



설명

LD Driver를 사용하면 디스플레이에 사용되는 단위를 포함하여 다양한 항목에 대한 기본 설정을 구성 
할 수 있습니다.  이전에 설명한 방법으로 구성된 기본 설정이 계속 사용됩니다. METAZAStudio에서도 
이러한 설정을 변경할 수도 있지만 변경 사항은 임시 설정으로만 사용되고 저장되지 않습니다.

절차

기본 드라이버 설정 변경
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[File] → [Setup the printer...] → [속성]을 클릭합니다.

[DGSHAPE LD-300 속성] 창이 나타납니다.  필요에 맞게 설정을 구성하십시오.



METAZAStudio에서 사용할 수있는 기타 작업

METAZAStudio에는 다양한 기타 기능이 포함되어 있습니다.
조작 방법에 대한 정보는 METAZAStudio의 온라인 도움말을 참조하십시오.

 P.10  "소프트웨어 도움말 표시"
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문제 해결

[전원/이동] 버튼이 깜박이는 경우

전원을 켤 때 헤드가 상승하나요?

렌즈가 기기에 올바르게 부착되어
있습니까?

마킹 표면의 높이 변화가 너무 
크지 않은가요?

P.17  "소재 준비"

헤드가 소재의 마킹 표면에 
닿습니까?

[전원/이동] 버튼을 누르면 램프가 깜박이지 않습니다.  소재의 
두께에 해당하는 소재 리테이너를 사용하여 올바르게 장착하십
시오.
P.20  "소재 장착(소재 두께 : 0 ~ 26mm)"
P.22  "소재 장착(소재 두께 : 0 ~ 26mm)"
P.26  "소재 장착(소재 두께 : 50 ~ 216 mm)"

마킹 데이터를 전송해도 기기가 작동하지 않는 경우

전원이 켜져 있습니까?

전원/이동 버튼 표시등이 켜져 있는지 확인합니다.  꺼져 있으면 
전원/이동 버튼을 눌러 전원을 켭니다.

P.9  "전원켜기"

전원 코드가 올바르게 연결되어 
있습니까?

올바르게 연결되지 않은 경우 올바르게 연결하십시오.

본체와 컴퓨터를 연결하는 방법은 설치 가이드를 참조하십시오.

컴퓨터 연결에 사용되는 케이블이 
올바르게 연결되어 있습니까?

연결 케이블이 분리되었는지 확인하십시오.

METAZAStudio에서 호일을 선택할 수 없는 경우

[Use printer driver settings] 확
인란이 선택되어 있습니까?

METAZAStudio가 시작된 직후 표시되는 [Select Foil] 창에서 
[Use printer driver settings] 확인란을 선택한 경우 호일을 선택
할 수 없습니다.  [Use printer driver settings] 확인란을 선택   
취소합니다.

METAZAStudio 이전 버전을 사용
하고 있습니까?

2.43 이전 버전의 METAZAStudio는 LD-300을 지원하지 않으
므로 호일을 선택할 수 없습니다. METAZAStudio의 최신 버전을 
설치하십시오.
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헤드가 최 상단 위치로 상승하기 때문에 기기는 소재의 표면    

높이가 마킹을 수행하기 위한 요구 사항을 충족하지 않는 것으로 

판단합니다.  [전원/이동] 버튼을 1 초 이상 눌러 전원을 끕니다.  

전원을 켤 때 불필요하게 헤드를 만지지 않도록 주의하십시오.

[전원/이동] 버튼을 1 초 이상 눌러 전원을 끕니다.  렌즈를 기기

에 부착하는 올바른 방법은 교체 렌즈에 동봉된 설명서를 참조하

십시오.

[전원/이동] 버튼을 1 초 이상 눌러 전원을 끕니다.  마킹 가

능한 소재의 상태를 확인하고 소재를 다시 선택하십시오.



Material과 Library 가 METAZAStudio에 표시되지 않는 경우

소프트웨어가 올바르게 설치 되었
습니까?

기기에 포함 된 DGSHAPE 소프트웨어 패키지 CD에서 
METAZAStudio 및 SFEdit2를 다시 설치하십시오.  이미 설치된 
소프트웨어를 제거하지 말고 소프트웨어를 다시 설치하십시오.

P.94  "소프트웨어와 설명서를 별도로 설치"

마킹 된 위치가 원하는 곳이 아닌 경우

레이저 포인터와 소재가 올바른 
위치에 장착되어 있습니까?

소재가 올바르게 장착되었는지 확인하십시오.   METAZAStudio
를 사용하여 소재에 배치하기위한 레이저 포인터를 조사합니다.  
필요에 따라 METAZAStudio에서 마킹 데이터의 위치를 조정합
니다.

P.20  "소재 장착(소재 두께 : 0 ~ 26mm)"
P.22  "소재 장착(소재 두께 : 0 ~ 26mm)"
P.26  "소재 장착(소재 두께 : 50 ~ 216 mm)"
P.37  "Step 4: 마킹 위치 및 크기 조정"

레이저는 대상에 조사되지만 아무
것도 인쇄되지 않습니다.

소재가 이 기기의 마킹요구 사항을 충족합니까?
마킹 가능한 소재를 준비하여 사용하십시오.

P.82  "마킹 조건 조정"
P.17  "소재 준비"

레이저 포인터의 조사 위치가 어긋
나 있습니까?

LD-300 Head Manager를 사용하여 레이저 포인터의 조사 
위치를 조정합니다.

P.50  "레이저 포인터 위치 조정"

P.52  "Light-absorbing 필름 교체"

호일의 앞면과 뒷면이 올바르지 
않습니까?

마킹하려는 호일의 광택 표면이 위를 향하도록 소재 위에 올려 
놓습니다.

문제 해결
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light-absorbing 필름의 앞/뒤면이 
잘못 부착 된 프레임을 설치 했습니
까?

light-absorbing 필름의 잘못된 면이 프레임에 부착 된 경우  
마킹이 수행되지 않습니다.  light-absorbing 필름을 처음 설치
할 때와 light-absorbing 필름을 교체 할 때 올바른 방향으로 
부착하십시오.



마킹 된 이미지의 품질이 좋지 않은 경우(고르지 않거나 변형 된 경우)

마킹 압력이 적절하지 않을 수 
있습니다.

부드러운 소재나 표면에 미세한 요철이 있는 소재에 마킹하려면 

더 큰 압력이 필요합니다.  마킹 압력을 높이면 마킹 결과가 향상 

될 수 있습니다.  레버를 레버의 현재 위치보다 큰 숫자인    또는     

   위치로 설정하십시오.  단단한 소재의 경우 마킹 압력을 줄이

면 마킹 결과가 향상 될 수 있습니다.  레버를 현재 위치보다    

낮은 숫자로 설정합니다.

P.82  "마킹 압력 조정"

호일 설정이 올바르게 설정되어 
있습니까?

P.83  "호일 등록 및 마킹 강도 조정"
P.32  "Step 1: 마킹 데이터 생성 준비"

렌즈의 수명이 다하지 않았습니까?

LD-300 Head Manager를 사용하여 렌즈의 상태를 확인할 수 
있습니다.  렌즈 사용 표시기가 디스플레이의 빨간색 부분에 도달
하면 렌즈를 새 것으로 교체하십시오.

P.51  "렌즈 수명 확인"

양방향 인쇄로 설정 되었습니까?

LD 드라이버 온라인 설명서("[Material] tab")

P.52  "Light-absorbing 필름 교체"

마킹 된 이미지가 항상 같은 위치에서 누락 되는 경우

마킹 할 표면의 높이 차이가 너무 
크지 않습니까?

마킹 할 표면의 높이 차이가 너무 클 수 있습니다.  기기로 마킹 할 
수있는 소재에 대한 요구 사항을 다시 확인하고 요구 사항을 충족
하는 소재를 사용하십시오.

P.17  "소재 준비"

P.52  "Light-absorbing 필름 교체"
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METAZAStudio에서 장착한 호일을 선택하십시오.
호일이 동일하더라도 표면 상태에 따라 인쇄 조건이 다릅니다.  
이러한 경우 마킹 압력의 미세 조정이 필요합니다.

양방향 마킹은 마킹 시간을 단축 할 수 있지만 이미지 품질이  
저하 될 수 있습니다.  이 경우 LD 드라이버 설정 창으로 이동 
하여 [Bidirection] 선택을 해제하고 마킹을 다시 수행하십시오.

 light-absorbing 필름의 같은 위치
에서 반복적으로 마킹을 하고 있습
니까?

Light-absorbing 필름에 같은 위치를 여러 번 사용하면 깨끗하
게 마킹 할 수 없습니다.  필름에 사용하지 않은 위치와 여러번 
사용 된 위치가 모두있는 경우 마킹이 고르지 않을 수 있습니다.  
사용하지 않은 위치가 마킹 할 범위를 덮도록 light-absorbing 
필름에서 사용중인 위치를 이동하여 다시 마킹을 수행합니다.

 light-absorbing 필름의 같은 위치
에서 반복적으로 마킹을 하고 있습
니까?

 Light-absorbing 필름에 같은 위치를 여러 번 사용하면 깨끗하
게 마킹 할 수 없습니다.  사용하지 않은 위치가 마킹 할 범위를 
덮도록 light-absorbing 필름에서 사용중인 위치를 이동하여  
다시 마킹을 수행합니다.



마킹 된 위치 외부에 남아있는 불필요한 호일을 제거해야하는 경우

호일이 의도하지 않은 위치에 남아 있으면 셀로판 테이프를 사용하여 불필요한 호일을 제거하십시오.

레이저 포인터 위치 조정을 실패하는 경우(Head Manager)

LD-300 Head Manager를 사용하여 처음부터 LP 위치 조정을 수행 한 후에도 오류 화면이 표시되고 
오류가 계속 발생하면 공인 Roland DG Corporation 대리점에 문의하십시오.

 P.50  "레이저 포인터 위치 조정"

별도로 드라이버 설치

LD 드라이버와 소프트웨어를 동시에 설치할 수도 있습니다.  이러한 모든 항목을 동시에 설치하려면 설치 
가이드를 참조하십시오.

절차 

A 관리자 또는 관리자 그룹의 구성원으로 Windows에 로그온 합니다. 

B DGSHAPE 소프트웨어 패키지 CD를 컴퓨터의 CD-ROM 드라이브에 넣습니다.

자동 실행 창이 나타나면 [Run menu.exe]를 클릭합니다.  [사용자 계정 컨트롤] 창이 나타나면 
[허용] 또는 [예]를 클릭합니다.  설정 메뉴가 자동으로 나타납니다.

C LD 드라이버가 이미 설치되어있는 경우 제거합니다.

 P.98  "드라이버 제거"
드라이버가 설치되지 않았거나 제거 된 경우 D 단계로 이동하십시오. 

D [Custom Install]을 클릭합니다.
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E LD 드라이버의 [Install]를 클릭합니다.

F [Install] 선택 후 Model은 [DGSHAPE LD-300], Port는 [USB]를 선택하고 [Start]를 클릭합니다.

LD 드라이버 설치가 시작되면 화면의 지시에 따라 진행하십시오.  

설치 중에 아래와 같은 화면이 나타나면 [Install]를 클릭합니다.

G 다음과 같이 표시되면 [Finish]를 클릭합니다.
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H 설정 메뉴 화면에서          를 클릭합니다.  

I CD-ROM 드라이브에서 CD를 꺼냅니다.

J USB 케이블을 사용하여 기기를 컴퓨터에 연결합니다.

번들 된 USB 케이블을 사용하십시오. USB 허브를 사용하지 마십시오.

LD 드라이버는 자동으로 설치됩니다.

소프트웨어와 설명서를 별도로 설치

절차

A 관리자 또는 관리자 그룹의 구성원으로 Windows에 로그온하십시오. 

B DGSHAPE 소프트웨어 패키지 CD를 컴퓨터의 CD-ROM 드라이브에 넣습니다.

자동 실행 창이 나타나면 [Run menu.exe]을 클릭합니다.  [사용자 계정 컨트롤] 창이 나타나면 
[허용] 또는 [예]를 클릭합니다.  설정 메뉴가 자동으로 나타납니다.

C [Custom Install]을 클릭합니다.
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D 설치할 소프트웨어 또는 설명서의 [Install]을 클릭합니다.

LD 드라이버 설치에 대한 자세한 내용은 P.92 "별도 드라이버 설치"를 참조하십시오.

E 메시지에 따라 소프트웨어를 설치하십시오.
[사용자 계정 컨트롤] 창이 나타나면 [허용] 또는 [예]를 클릭하여 설치를 계속합니다.

G CD-ROM 드라이브에서 CD를 꺼냅니다.

드라이버 설치가 불가능한 경우

도중에 설치가 종료되거나 USB 케이블로 연결할 때 마법사가 나타나지 않으면 LD 드라이버가 설치되지 
않았을 수 있습니다.  이러한 경우 다음 절차를 수행하십시오.(절차 A로 문제가 해결되지 않으면 절차 B
를 수행하십시오.)

Windows 10/8.1 (절차 A)

절차

A USB 케이블을 사용하여 기기를 컴퓨터에 연결하고 기기의 전원을 켭니다.

B [데스크톱]을 클릭합니다.

C 아래 절차에 따라 [장치 및 프린터 보기] (또는 [장치 및 프린터])를 클릭합니다.

Windows 10

① [시작] 메뉴를 클릭합니다.

② [Windows 시스템]을 클릭하고 [제어판]을 클릭합니다.

③ [장치 및 프린터 보기]를 클릭합니다.
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F 설치가 완료되면 설정 메뉴 화면에서          를 클릭합니다. 



Windows 8.1

① [시작] 버튼을 마우스 오른쪽 버튼으로 클릭하고 [제어판]을 클릭합니다.

② [장치 및 프린터]를 클릭합니다.

I 그래도 문제가 해결되지 않으면 "Windows 10 / 8.1 (절차 B)"의 절차를 수행하십시오.

Windows 10/8.1 (절차 B)

절차

A USB 케이블을 사용하여 기기를 컴퓨터에 연결하고 기기의 전원을 켭니다.

B [새 하드웨어 발견] 창이 나타나면 [취소]를 클릭하여 닫습니다.  이 기기 이외의 프린터 용 USB 
      케이블을 분리합니다.

J 컴퓨터에서 USB 케이블을 분리하고 Windows를 다시 시작합니다.

K Windows 드라이버를 제거하십시오.  P.98 "Windows 10 / 8.1"의 3 단계부터 단계를 수행하여 
      드라이버를 제거합니다.

L "설치 가이드"( "소프트웨어 설치") 또는 P.92 "별도로 드라이버 설치"의 절차에 따라 드라이버를 다시 
       설치하십시오.
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D 사용할 모델이 "지정되지 않음"아래에 표시되는지 확인하십시오.

E 사용할 모델의 아이콘을 마우스 오른쪽 버튼으로 클릭하고 [장치 제거]를 클릭합니다.

F "이 장치를 제거 하시겠습니까?"라는 메시지가 표시되면 가 표시되면 [예]를 클릭합니다. 

G 사용할 모델의 아이콘이 "지정되지 않음" 아래에  표시되지 않는지 확인하십시오. 

H 기기를 컴퓨터에 연결하는 USB 케이블을 일시적으로 분리하고 다시 연결하십시오.  사용중인 기기의

      프린터 아이콘이 "프린터"아래에 표시되면 Windows 드라이버가 성공적으로 설치된 것입니다.

C [Desktop]을 클릭합니다.

D [시작] 버튼을 마우스 오른쪽 버튼으로 클릭하고 [장치 관리자]를 클릭합니다.

E [사용자 계정 컨트롤] 창이 나타나면 [계속]을 클릭합니다.  [장치 관리자]가 나타납니다. 

F [보기] 메뉴에서 [숨김 장치 표시]를 클릭합니다.

G 목록에서 [프린터] 또는 [기타 장치]를 찾아 더블 클릭합니다.  선택한 항목 아래에 나타나는 
      모델 이름 또는 [알 수없는 장치]를 클릭합니다.

H [동작] 메뉴에서 [제거] 또는 [장치 제거]를 클릭합니다.

I "장치 제거 확인"창에서 [확인]을 클릭합니다.  또는 "장치 제거"창에서 [제거]를 클릭합니다.  
      [장치 관리자]를 닫습니다.



Windows 7 (절차 A)

절차

A USB 케이블을 사용하여 기기를 컴퓨터에 연결하고 기기의 전원을 켭니다.

사용  할 기기의 프린터 아이콘이 "프린터"아래에 표시되면 Windows 드라이버가 성공적으로 설치된 것
입니다.  그래도 문제가 해결되지 않으면 "Windows 7 (절차 B)"의 절차를 수행하십시오.

Windows 7 (절차 B)

절차

A [새 하드웨어 발견] 창이 나타나면 [취소]를 클릭하여 닫습니다.

B [시작] 메뉴를 클릭하고 [컴퓨터]를 마우스 오른쪽 버튼으로 클릭하여 [속성]을 클릭합니다.

C [장치 관리자]를 클릭합니다.  [사용자 계정 컨트롤] 창이 나타나면 [계속]을 클릭합니다.  
      [장치 관리자]가 나타납니다.

H 컴퓨터에서 USB 케이블을 분리하고 Windows를 다시 시작합니다.

I Windows 드라이버를 제거하십시오.  P.99 "Windows 7"의 3 단계부터 단계를 수행하여 드라이버를
      제거합니다.

J "설치 가이드"( "소프트웨어 설치") 또는 P.92 "드라이버 분리 설치"의 절차에 따라 드라이버를 다시 
       설치하십시오.
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B [시작] 메뉴를 클릭하고 [장치 및 프린터]를 클릭합니다.

C 사용 할 모델이 "지정되지 않음"아래에 표시되는지 확인하십시오.

D 사용 할 모델의 아이콘을 마우스 오른쪽 버튼으로 클릭하고 [문제 해결]을 클릭합니다.

E "이 장치에 대한 드라이버 설치" 메시지가 표시된 화면이 표시되면 [이 수정 사항 적용]을 클릭
       합니다. 

F "기본 프린터로 설정"을 묻는 메시지가 표시되면 [이 수정본 건너뛰기]를 클릭합니다.

G "문제 해결이 완료되었습니다" 메시지가 표시되면 [문제 해결사 닫기]를 클릭합니다.

D [보기] 메뉴에서 [숨김 장치 표시]를 클릭합니다.

E 목록에서 [기타 장치]를 찾아 더블 클릭합니다.  선택한 항목 아래에 나타나는 모델 이름 또는
      [알 수없는 장치]를 클릭합니다.

F [동작] 메뉴에서 [제거]를 클릭합니다.

G "장치 제거 확인"창에서 [이 장치의 드라이버 소프트웨어를 삭제합니다.]를 선택하고 [확인]을
      클릭하여 [장치 관리자]를 닫습니다.



드라이버 제거

LD 드라이버를 제거하려면 다음 절차를 수행하십시오.

Windows 10/8.1

절차

* 아래의 절차를 따르지 않고 드라이버를 제거하면 재설치가 불가능할 수 있습니다.

B Windows에 관리자로 로그온하십시오.

C [데스크탑]을 클릭합니다.

D 아래 절차에 따라 [제어판]을 클릭합니다.

Windows 10
① [시작] 메뉴를 클릭합니다.
② [Windows 시스템]을 클릭하고 [제어판]을 클릭합니다.

Windows 8.1
① [시작] 버튼을 마우스 오른쪽 버튼으로 클릭하고 [제어판]을 클릭합니다.

E [프로그램 제거]를 클릭합니다.

F 제거할 기기의 Windows 드라이버를 클릭하여 선택하고 [제거]를 클릭합니다.  
      [사용자 계정 컨트롤] 창이 나타나면 [허용] 또는 [예]를 클릭합니다.

L [제거]를 클릭합니다.  제거 할 기기를 선택하고 [시작]을 클릭합니다.

M 컴퓨터를 다시 시작해야하는 경우 다시 시작할 것인지 묻는 창이 나타납니다.  [예]를 클릭 
      합니다.

N 컴퓨터가 다시 시작된 후 제어판을 다시 열고 [장치 및 프린터 보기] 또는 [장치 및 프린터]를 
      클릭합니다.

문제 해결
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A 기기의 전원을 끄고 기기와 컴퓨터 사이의 케이블을 분리합니다.

G 제거를 확인하는 메시지가 나타나면 [예]를 클릭합니다.

H [시작]을 마우스 오른쪽 버튼으로 클릭하여 [데스크톱]을 클릭합니다.

I 탐색기를 열고 Windows 드라이버가 포함된 드라이브와 폴더를 엽니다. (*) 

J "SETUP64.EXE"(64 비트 버전) 또는 "SETUP.EXE"(32 비트 버전)를 더블 클릭합니다.

K [사용자 계정 컨트롤] 창이 나타나면 [허용] 또는 [예]를 클릭합니다. Windows 드라이버용 
      설치 프로그램이 시작됩니다.



O 제거 할 기기의 아이콘이 보이면 마우스 오른쪽 버튼으로 클릭하고 [장치 제거]를 클릭합니다.
(*) CD-ROM을 사용할 때 아래와 같이 폴더를 지정하십시오. 
(이것은 CD-ROM 드라이브가 D 드라이브라고 가정합니다.) 
D : \ Drivers \ WINX64 (64 비트 버전)
D : \ Drivers \ WINX86 (32 비트 버전)
DGSHAPE 소프트웨어 패키지 CD를 사용하지 않는 경우 DGSHAPE Corporation 웹 사이트로 이동
하십시오.
(http://www.dgshape.com/) 제거하려는 기기의 Windows 드라이버를 다운로드 한 다음 다운로드 
한 파일을 추출 할 폴더를 지정합니다.

Windows 7

절차

* 아래의 절차를 따르지 않고 드라이버를 제거하면 재설치가 불가능할 수 있습니다.

A 드라이버 제거를 시작하기 전에 컴퓨터에서 USB 케이블을 분리하십시오. 

B Windows에 관리자로 로그온하십시오.

C [시작] 메뉴에서 [제어판]을 클릭합니다.  [프로그램 제거] 또는 [프로그램 및 기능]을 클릭
      합니다.

I [사용자 계정 컨트롤] 창이 나타나면 [허용]을 클릭합니다.

J Windows 드라이버용 설치 프로그램이 시작됩니다.

K [제거]를 클릭합니다.  제거 할 기기를 선택하고 [시작]을 클릭합니다.

L 컴퓨터를 다시 시작해야하는 경우 다시 시작할 것인지 묻는 창이 나타납니다.  
      [예]를 클릭합니다.

(*)CD-ROM을 사용할 때 아래와 같이 폴더를 지정하십시오. 
(이것은 CD-ROM 드라이브가 D 드라이브라고 가정합니다.) 
D : \ Drivers \ WINX64 (64 비트 버전)
D : \ Drivers \ WINX86 (32 비트 버전)
DGSHAPE 소프트웨어 패키지 CD를 사용하지 않는 경우 DGSHAPE Corporation 웹 사이트로 이동
하십시오.
(http://www.dgshape.com/) 제거하려는 기기의 Windows 드라이버를 다운로드 한 다음 다운로드 
한 파일을 추출 할 폴더를 지정합니다.

문제 해결
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D 제거할 기기의 Windows 드라이버를 클릭하여 선택하고 [제거]를 클릭합니다. 

E 제거를 확인하는 메시지가 나타나면 [예]를 클릭합니다.

F 작업 표시 줄에서 [시작], [모든 프로그램], [보조 프로그램], [실행], [찾아보기]를 차례로 클릭
      합니다. 

G Windows 드라이버가있는 드라이브 또는 폴더의 이름을 선택하십시오. (*)

H "SETUP64.EXE"(64 비트 버전) 또는 "SETUP.EXE"(32 비트 버전)를 선택하고 [열기]를 클릭한
       다음 [확인]을 클릭합니다.

M 컴퓨터가 다시 시작되면 제거가 완료됩니다.



기기 이동

Important!

기기를 이동할 때 아래 설명 된 제거/장착 절차를 수행하십시오.  그렇게하지 않고 기기를 이동하면 기
기가 손상 될 수 있습니다.

작업을 수행하는 동안 레일을 만지지 마십시오

불필요하게 레일을 만지면 그리스가 제거되어 레일이 녹슬게 됩니다.

레일

Step 1: 기기에서 소재 리테이너 제거

절차
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A 전원이 꺼져 있는지 확인하십시오.

B 전원 코드와 같은 모든 케이블을 분리합니다.

C 베이스 테이블을 제외한 모든 소재 리테이너를 제거합니다.



Step 2: 리테이너를 기기에 장착

절차 

A 이 기기 뒷면에 보관되어있는 리테이너 A, B, C를 제거합니다.

리테이너 B,C

리테이너 A

B 헤드를 중앙의 뒤쪽으로 천천히 움직입니다. 

C 리테이너 B와 C를 부착합니다.

육각 렌치(대)

리테이너 B

육각 렌치(대) 

리테이너 C

D 헤드를 천천히 왼쪽으로 이동합니다.
너무 세게 움직이지 않도록 주의하십시오.

헤드

기기 이동
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E 잠금 레버를    로 설정합니다. 

F 헤드를 들어 올리면서 리테이너 A를 부착합니다.

리테이너 A

육각 렌치(대) 

그림에 표시된 위치를 들어 올립니다.

G 기기의 커버를 닫습니다. 

H 기기를 다시 포장하십시오.

기기 이동
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레버 아래에서 리테이너 A를 눌러 리테이너를 제자리에 고정합니다.  리테이너를 고정하고 헤드가 
위아래로 움직이지 않는지 확인하십시오.

기기를 옮길 때 반드시 두 손으로 바닥을 받쳐주세요.  다른 위치에서 기기를 잡으면 기기가 손상 
될 수 있습니다.



작업 영역

베이스 테이블

단위 : mm

363

267 

라이징 테이블

단위 : mm

320

240 
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소재 리테이닝 프레임

단위 : mm

281 

213 
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마킹 영역

최대 마킹 영역

단위 : mm

271

9.
5

9.
5

11.1 11.1 
192 

필름 프레임

라이징 테이블

베이스 테이블

레이저 조사 영역

단위 : mm

305

230 

라이징 테이블

베이스테이블
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레이저 포인터 조사 영역

단위 : mm

265

230 

베이스 테이블

전력 등급 및 일련 번호 라벨의 위치

본체 뒷면

AC 어댑터

전력 등급
제공된 전압, 주파수 및 전류 요구 사항을 충족하는 
전기 콘센트를 사용하십시오.

일련 번호
유지 보수, 서비스 또는 지원을 요청 때 필요합니다.  
라벨을 벗기거나 훼손시키지 마십시오.

전력 등급
제공된 전압, 주파수 및 전류 요구 사항을 충족하는 
전기 콘센트를 사용하십시오.
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